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Exciting New Changes 

It is exciting to live at a time when so many new resources are being made available for Family 
History research. Ohana Software is happy to be part of this community of researchers. With the 
New FamilySearch coming closer to becoming a reality, it is time to prepare your files for the 
future. The latest version of PAF Insight helps you do that by suggesting some simple steps when 
you open a file. You might think that you don't have duplicates that need to be merged, or extra 
pedigrees in your file, but even the most diligent and careful genealogists have found these 
problems lurking in their files waiting to be cleaned up. Almost everyone who hasn't taken the time 
to clean up their file has these issues. The two previous newsletters dealt with the Merge and Edit 
RINS and Pedigree modes of PAF Insight. This month we focus on the Edit Places mode. We 
encourage everyone to take a look at their file in these modes.

• Make sure that Place names are as complete as possible, spelled correctly and in the right 
format. 

• Merge duplicate records in your files. 
• Delete unwanted, unattached pedigrees in your file. 

The New FamilySearch will allow you to tie your family into other pedigrees that connect to yours. 
It will also allow for various opinions on data. You can dispute information that will be on the new 
website for individuals in your Family Tree, but only the submitter can delete incorrect information. 

The New FamilySearch will be a marvelous website but it is up to us to make sure that the 
information in our files is clean and accurate. Cleaning up your file now will save you time and 
effort in the future. 

Lessons on all of the modes of PAF Insight can be found on the Ohana Software lessons page . 
They are in PDF format and can be saved to your computer, printed or viewed online. 

The latest and probably final version for Windows 98 and ME is version 2006.11.4. If you are 
using Window 98 or ME, please go to the Edit menu in PAF Insight and choose Preferences. Then 
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click on the General tab and uncheck "Automatically check for updates". This way you will not be 
bothered by update messages in the future.

Insights into Insight: Edit Places 

The Edit Places mode has quickly gained popularity with our users because it fills such a crucial 
need. You can print a list of place names from PAF but you cannot see them listed together within 
the program for easy editing. I attempted cleaning place names by scanning the places listed in the 
Individual view of PAF. I also tried using Global Search and Replace and sometimes ended up with 
incredibly strange results. PAF Pal helped immensely by expanding abbreviated states and adding 
USA yet when I first opened my file in Edit Places I was shocked by what I found lurking there. If 
you have not looked at your file in the Edit Places mode, I hope you will after reading the following 
tips and tricks. 

When I sort records from largest to smallest, it still reads town, county, state, country. That looks 
like smallest to largest to me! Please explain!

Recent changes to PAF Insight allow you to sort your places from largest to smallest or smallest to 
largest geographic location. Sorting by Largest to smallest groups places together by country, then 
by state or province, then county and finally by town. The program does not rewrite the places or 
make them appear as country, state, county, town but simply sorts them according to the specified 
order. Smallest to largest groups all towns with the same name together then adds the county, 
state/province and country to complete the sort. 

Is there some way to find counties in Edit Places?

Find all occurrences of a specific place, such as a county, by clicking into the Find field and typing 
the county you want. The highlight jumps to the first instance of the name you entered. Click the 
Find Next button to jump to the next occurrence of that place. Repeat as needed. Use Find 
Previous to return to prior listings. FYI, Find Next and Find Previous buttons appear in all the 
modes and work without changing your sort options. 

Now that I see problems, how do I go about making the corrections? 

There are two methods for correcting place names. One method works best when you cannot see a 
correct version of the place name. The other works best when you find multiple but inconsistent 
entries of the same place.

Normal Editing - Best used when there is no correct version of the place name.

• Double click on the place that needs correcting. 

• Use the arrow keys on your keyboard to position your cursor and type the changes into this 
field. 



• Corrects all instances of this exact place name. 

• Will not globally correct the specific parts of the name you fixed even if it occurs the 
same way in another entry. 

• Example: If you correct the spelling of Massachusetts as it occurs with Boston 
it will not correct an identical misspelling of Massachusetts with Salem, or 
Plymouth.

Drag and Drop - Best used when you have a correct version of the place name.

• Select a place that needs correcting.

• Using the drag and drop method, move it to the correct place name in your list.

• When using this method, a window will appear to verify the changes you want to make.

• Click OK or Cancel

Spotlight on: Passage Express 

Part of the fun of eating in a nice restaurant is the beautiful presentation of the food. I also think it 
tastes better because it looks so good. Family History enthusiasts may find, like culinary artists, that 
the family likes what we "serve" them, when it is invitingly packaged. When we decide to share our 
photos and documents, video and audio clips or PAF files we hope our family will enjoy looking at 
them and want to use them but simply burning everything onto a CD may not be very inviting. You 
can take those same files and use Passage Express to create an enjoyable an interesting presentation 
that retains the ability to save the files for use in other projects. 

It took me a while to grasp the concept of creating a presentation without inserting photos and 
documents onto a background or template as you would with PowerPoint, Photo Shop or an 
electronic photo album. If you have folders of photographs, you can import that folder into Passage 
Express and use the Build a Project mode to add captions, dates, face labels, and sound to each 
photograph. You can also arrange the pictures in a specific order. In the Design Menu, you create 
an opening screen to enhance the look or your project and provide options for using the CD. 

The CD you create automatically opens to your menu and the user chooses to browse the files or 
search for a particular item. In the browse mode, they can see a slideshow and hear the narration or 
music attached to the file. The Search mode uses the annotations you made to a photo to retrieve a 
list of files matching the users search criteria. If they type in "Grandpa" as their search criteria, any 
file with "Grandpa" as a caption or face label will be listed. If the CD contains a PAF file, the 
recipient of your CD can either open it with their PAF program or install a small program called 
GenViewer and look at the records in that program. GenViewer comes with Passage Express and 
may be included on your CDs. Passage Express and GenViewer can also use Ancestral Quest, 
Legacy, or Roots Magic files. 

Even with embellishments, the individual files can still be opened and saved onto the user's 



computer. The ability to enjoy the presentation yet save each file for later use means that not only 
are your records presented in an enjoyable manner but they are usable by the recipient. After all, 
don't we want our families to become excited about their family history and use what you give 
them? 

Organizing your electronic photographs and documents is important. If the presentation is about a 
family, you may want one file with the surname of the family. Within that file, you may have sub 
files for each person in the family; the mother, father and all the children. You may also want 
additional files for homes, group photos, vacations, or other themes. As you evaluate what to 
include in your project you may need to rename or reorder the files. 

I urge you to use the Help files, particularly the Get Started link at the bottom of the Introduction 
to Passage Express page. The first sentence in this tutorial says, "The best way to get acquainted 
with Passage Express is by creating a simple, quick and easy project." and I agree. Take it one bite 
at a time. Test each button and each tab to see what it does. Print the instructions and go through 
them systematically. Play and enjoy the learning process. The more I experimented the more I was 
amazed by its power and versatility. 

Magic Words 

From fairy tails to science fiction, magic words overcome the spells guarding vast treasures, 
transform mice into horses that can pull a carriage transformed from a pumpkin, or stop a robot 
from destroying the world. Magic words have power. So do usernames, passwords and license 
keys. They protect personal information, guard access to your email, grant access to online 
information, and verify you paid for the use of certain programs and website. Some are computer 
generated and some you create yourself but unless they are used properly, they will not achieve the 
desired affect. The mouth of the cave would have remained shut if Ali Baba said "Bibbidi-Bobbidi-
Boo", Cinderella would not have danced with the handsome prince had her fairy godmother waved 
her magic wand and uttered "Klaatu barada nikto" and you will not be able to open PAF insight 
without using the correct license key and its accompanying username. Likewise, PAF Insight will 
not be able to log onto the FamilySearch website if you do not provide the correct username and 
password. 

I hope the following helps you understand the differences between all the magic words you need for 
our website, installing our programs, and using the IGI search mode of PAF Insight

The Ohana Software website customer area login 

• Requires the username or email address and the password YOU created during 
registration at our website

• Grants access to your contact information for updating

• Permits access to the license key and username for the programs you purchased from 
us.



Installing PAF Insight

• Requires the COMPUTER generated license key and username that act as proof of 
purchase for the program.

• These work as a pair to unlock the use of the program.

• They are case and space sensitive and must be entered correctly to finalize the 
installation. 

• Do not confuse this computer generated username with the customer area login 
username you created when you registered. They are generally different.

IGI Search mode

• Requires your FamilySearch username and password. 

• PAF Insight submits this information to www.familysearch.org and signs on for you.

• Ohana Software does not have this information. 

• Retrieve your username and password from www.familysearch.org by clicking on the Sign 
On link and choosing the link that says,"If you have forgotten..." 

• Once you have the correct username and password, enter that into PAF Insight

• The Search IGI mode may bring up a window asking you to enter the correct 
username and password or you can go to the Edit menu and select Preferences and 
enter them into the appropriate fields.

Abracadabra! Alakazam and Hocus pocus!! No more problems!!!

Thank you!

You each have our heart-felt gratitude for your patience this month. During the malfunctions on the 
FamilySearch website we had the opportunity to hear from many of you. Circumstances tried your 
patience but you remained gracious and understanding. You are the best customers in the world! 
Thank you
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